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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP8027 QFN40 BLDC Motor Driver Evaluation Board. Items discussed in this 
chapter include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP8027 QFN40 BLDC Motor Driver 
Evaluation Board. The manual layout is as follows:

• Chapter 1. “Product Overview” – Important information about the MCP8027 
QFN40 BLDC Motor Driver Evaluation Board. 

• Chapter 2. “Installation and Operation” – Includes instructions on installing and 
using the MCP8027 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix A. “Schematics and Layouts” – Shows the schematic and layout
diagrams for the MCP8027 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
MCP8027 QFN40 BLDC Motor Driver Evaluation Board.

• Appendix C. “Software” – Provides information about the demo application and 
where the source code can be found.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS50003682A-page 6  2024 Microchip Technology Inc. and its subsidiaries



Preface
RECOMMENDED READING

This user's guide describes how to use the MCP8027 QFN40 BLDC Motor Driver 
Evaluation Board. Other useful documents are listed below. The following Microchip 
documents are available and recommended as supplemental reference resources.

• MCP8027 - “3-Phase Brushless DC (BLDC) Motor Gate Driver with Power 
Module and Sleep Mode” (DS20006897) 

• dsPIC33CK256MP508 Family Data Sheet (DS70005349) 

• AN1078 - “Sensorless Field Oriented Control of PMSM Motors” (DS01078)

• AN1160 - “Sensorless BLDC Control with Back-EMF Filtering Using a 
Majority Function” (DS01160)

• AN992 - “Sensorless BLDC Motor Control Using dsPIC30F2010” (DS00992)

• AN1292 - “Sensorless Field Oriented Control (FOC) for a Permanent Magnet 
Synchronous Motor (PMSM) Using a PLL Estimator and Flux Weakening 
(FW)” (DS01292)

• AN901 - “Using the dsPIC30F for Sensorless BLDC Control” (DS00901)

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip's customer notification service helps keep customers current on Microchip 
products. Subscribers will receive an e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers - The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB® C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators - The latest information on Microchip in-circuit emulators.This includes 
the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers - The latest information on the Microchip in-circuit 
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3/4 
Debug Express.

• MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows 
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 7
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Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers - The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2, 3 and 4 programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (June 2024)

• Initial release of this document.
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Chapter 1.  Product Overview
1.1 INTRODUCTION

This chapter covers the following topics:

• MCP8027 QFN40 BLDC Motor Driver Evaluation Board Overview

• What is the MCP8027 QFN40 BLDC Motor Driver Evaluation Board?

• What does the MCP8027 QFN40 BLDC Motor Driver Evaluation Board Kit 
Include?

1.2 MCP8027 QFN40 BLDC MOTOR DRIVER EVALUATION BOARD OVERVIEW
The MCP8027 QFN40 BLDC Motor Driver Evaluation Board is used to demonstrate the 
drive capabilities/facilities offered by the MCP8027 in BLDC/PMSM motor applications. 

The board is designed to be very versatile, two-layered, low-cost, high-current, and 
easily configurable to meet as many customer's preferences as possible by using the 
MCP8027 for 3-Phase Brushless DC (BLDC) motor gate driver and the 
dsPIC33CK128MP503 microcontroller provided by Microchip. In order to implement 
different types of algorithms, like sinusoidal single shunt FOC or trapezoidal motor 
control algorithm in sensored or sensorless mode, the board can be easily configured 
by using the jumpers that are available on the board.

As provided, the MCP8027 QFN40 BLDC Motor Driver Evaluation Board is ready to 
drive a AC300022 - 24V 3-Phase Brushless DC Motor. The board is equipped with a 
Start/Stop button and a potentiometer that can be used to adjust the speed of the motor. 
The evaluation board can drive a BLDC motor with a supply voltage of up to 28V and 
a motor current up to 20A (rms). The MCP8027 QFN40 BLDC Motor Driver Evaluation 
Board provides a configurable 3.3V, 750 mW buck converter, 5V and 12V LDO, 
high-to-low level voltage translators, current sense operational amplifiers, and Hall 
effect sensors inputs.

Several key test points are available on the board in order to facilitate the user's 
measurements, tuning, and motor control optimization. 

The evaluation board provides a LED for the fault status indication and six on-board 
LEDs for signaling the Pulse-Width Modulation (PWM) presence.
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 9
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FIGURE 1-1: MCP8027 QFN40 BLDC Motor Driver Evaluation Board Block Diagram.

1.3 WHAT IS THE MCP8027 QFN40 BLDC MOTOR DRIVER EVALUATION 
BOARD?

The input operating voltage range for the board is +6V to +28V. The on-board 
MCP8027 generates 5V and 12V using internal voltage regulators. The MCP8027 also 
contains an internal buck regulator configured to provide 3.3V required for 
dsPIC33CK128MP503 host microcontroller.

An input terminal block is provided to apply the input voltage to the board. An output 
header connector and plated Printed Circuit Board (PCB) through-hole pads are also 
provided in order to connect the external motor. A programming header connector is 
available for updating the firmware contained in the dsPIC33CK128MP503 using a 
PICkit™ 3(4) programmer/debugger.

An input terminal block is also supplied on the board, to allow users to connect 5V/3V3 
Hall sensors.

For UART external communication, the user has the possibility to attach a Serial 
Communication Interface device through header J3.

For other purposes, a 2-pin connector can be planted on the board for communication 
with the microcontroller using MCP8027's internal level translator.

Finally, the PCB layout design can serve as a reference for the users who want a robust 
and low-cost, two-layered, low-voltage, high-current board.

1.4 WHAT DOES THE MCP8027 QFN40 BLDC MOTOR DRIVER EVALUATION 
BOARD KIT INCLUDE?

The MCP8027 QFN40 BLDC Motor Driver Evaluation Board kit includes:

• The MCP8027 QFN40 BLDC Motor Driver Evaluation Board (EV83F07A)

• Key Information Sheet

Controller
dsPIC33CK
xxxMPx03

External
Commands

Motor
Driver
MCP8027

MOSFET
BRIDGE

VBuckUA
RT

DE2

PWM

Fault

High Side

Low Side

Phase

iSense

BLDC

6..28V

Sensors

Current
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Chapter 2.  Installation and Operation
2.1 INTRODUCTION
The MCP8027 QFN40 BLDC Motor Driver Evaluation Board demonstrates the features 
of Microchip's 3-Phase Brushless DC (BLDC) Motor Driver with Power Module, 
MCP8027, used in a BLDC motor driver application. When used in conjunction with a 
microcontroller, the MCP8027 will provide the necessary drive signals to drive a 
3-Phase BLDC motor.

The MCP8027 contains all necessary functional blocks for developing high 
performance BLDC/PMSM motor drivers: high and low-side MOSFETs drivers, bias 
generators, OPAMPs, protection circuity and communication interface for the 
configuration of the internal circuitry. The motor phase current can be measured using 
the two-shunt technique described in AN1078. The MCP8027 provides three current 
sense amplifiers, which can be used for implementation of advanced control 
algorithms, such as Field-Oriented Control (FOC). The board is equipped with a 
dsPIC33CK128MP503 high-performance Digital Signal Controller (DSC) and is able to 
handle simple motor control algorithms like the 6-step one and high-performance 
algorithm like the Field Oriented Control (FOC).

A dsPIC33CK128MP503 processor is used to supply the PWM inputs to the MCP8027 
as well as handle the high-speed Analog-to-Digital Conversion (ADC) required for up 
to 50 kHz PWM operation. This dedicated microcontroller sustains a large range of 
motor control applications due to its specific synchronization between different 
peripherals. In order to demonstrate the MCP8027 capabilities, the evaluation board 
firmware that uses a trapezoidal drive control algorithm is available on the Microchip 
website.

2.2 FEATURES
The MCP8027 QFN40 BLDC Motor Driver Evaluation Board has the following features:

• Input operating voltage range: +6.0V to +28V
• Maximum of 500 mA of gate drive current for external N-Channel MOSFETs
• Drives up to a 20A RMS BLDC motor
• 750 mW buck regulator with resistor-programmable output voltage
• ON/OFF momentary contact switch (RUN)
• Reset momentary contact switch (RST)
• Spare user-programmable momentary contact switch (PB1)
• PWM signal LED indicators.
• Fault signal LED indicator.
• PICkit™ 3(4) debugger interface
• Speed control potentiometer
• Terminal block for 3.3V and 5V Hall effect sensors
• UVLO, OVLO and DUVLO protections
• Programmable external MOSFET overcurrent protection
• Programmable PWM dead-time protection
• Programmable PWM blanking time for current switching spikes
• Complete “C” source code (provided on the board webpage)
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 11
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2.3 GETTING STARTED

The MCP8027 QFN40 BLDC Motor Driver Evaluation Board is fully assembled and 
tested for driving a BLDC motor. The board can be easily configured to drive a BLDC 
motor in sensored or sensorless mode, as well as for sinusoidal triple shunt FOC or 
trapezoidal motor control algorithm. This board requires the use of an external voltage 
source capable of supplying 6V to 28V at the rated motor current. The board is 
presented in Figure 2-1. A BLDC motor is also required to evaluate the motor driver.

FIGURE 2-1: MCP8027 QFN40 BLDC Motor Driver Evaluation Board PCB.

2.3.1 Connections

2.3.1.1 JUMPER SETTINGS

The MCP8027 QFN40 BLDC Motor Driver Evaluation Board has several 
user-configurable jumpers. The jumpers are described in Table 2-1 below. The 
configuration jumpers positioning is illustrated in Figure 2-2:

TABLE 2-1: MCP8027 QFN40 BLDC MOTOR DRIVER EVALUATION BOARD 
JUMPERS

Jumper Positions Function Description

R78, R79, R80 Hall/Ph Hall or BEMF are selected for monitoring

R82 3V3/5 3.3/5V Hall power voltage selection

Jp 7 12V 12V for bootstrap

R81 3V3/5 3.3/5V bias voltage for Op-amps
DS50003682A-page 12  2024 Microchip Technology Inc. and its subsidiaries
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FIGURE 2-2: Board's Jumpers Positioning.

The board can be easily configured for different types of motor and control algorithms:

• BLDC Trapezoidal sensorless based on BEMF null cross detection.

• BLDC Trapezoidal based on sensor position detection.

• PMSM, FOC, single shunt sensorless (with/without wind milling).

• PMSM, FOC, single shunt based on sensor position detection.

Table 2-2 describes the jumper's settings for mode for these motor control types.

TABLE 2-2: MOTOR CONTROL MODE SETUP

Jumper Positions  Description

Trapezoidal/FOC Sinusoidal Sensorless Mode

R78,
R79,
R80

BEMF Connect PhX → ADC via R78.B, R79.B, R80.B 0R resistors

Trapezoidal/FOC Sinusoidal Sensored Mode

R78,
R79,
R80

HALL Hall Outputs → uCtrl. via R78.A, R79.A, R80.A 0R resistors
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 13
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FIGURE 2-3: Sinusoidal Motor Control Mode.

For the same motor, Figure 2-3 shows the currents for sensorless sinusoidal mode, 
taken on this board.

2.3.1.2 AVAILABLE INTERFACING CONNECTORS

For external communication board interfacing, six connectors are available.

• J2 is mainly dedicated for microcontroller programming/debugging. After this step 
is finalized, it can be used for other purposes e.g. for rotary encoder interfacing 
due to microcontroller pin remapping feature. 

• J3 is a simple header connector that can be used for serial communication using a 
PICkit serial communication tool or an USB to serial bridge (e.g. ADM00559 
provided by Microchip).

• HVI-ext (not populated) can be used for external Wakeup command when SLEEP 
mode was induced or as adapter for high level command transmitter. 

• J4 is a connector used to connect the Hall effect sensors to the 
dsPIC33CK128MP503 microcontroller available on the board. 

- Before connecting the Hall effect sensors, the user must make sure that the 
Hall effect sensors are powered with the right voltage by putting the R82 0R 
resistor in location R82.A for 3.3V or in location R82.B for 5V. 

- The user must also check if the R78, R79 and R80 0R resistors are in the 
correct location to select the Hall effect sensors (R78.A, R79.A and R80.A).

- The included firmware is for sensorless only.

• JM1 is the motor driver output. This is the connection to the BLDC motor.

• J1 is the power supply connection. This board needs to be connected to a power 
supply with an output range of 6 to 28V, according to the voltage ratings of the 
motor used by the user.

2.3.1.3 POWERING THE MCP8027 QFN40 BLDC MOTOR DRIVER 
EVALUATION BOARD

• Apply the input voltage to the input power terminal block J1. The input voltage 
source should be limited to +28V. For proper operation the input voltage should be 
in concordance with the motor rated voltage. Connect the positive side of the input 
power source (+) to pin 2 of J1. Connect the negative or return side (-) of the input 
source to pin 1 of J1. Refer to Figure 2-2.
DS50003682A-page 14  2024 Microchip Technology Inc. and its subsidiaries
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2.3.1.4 CONNECTING A MOTOR TO THE MCP8027 QFN40 BLDC MOTOR 
DRIVER EVALUATION BOARD

• Connect each phase winding of a 3-phase BLDC motor to the appropriate 
terminal on the board (A, B and C).

2.3.2 Operating a Motor

Step 1. Turn the SPEED adjust potentiometer (RV1) fully counterclockwise to obtain 
the slowest speed setting. Now turn the speed adjust approximately ¼ turn clockwise 
to allow for 25% motor speed.

Step 2. Turn on the power supply. At this moment, the yellow Fault LED is blinking at 
around 10 Hz.

Step 3. Press and release the RUN switch (ST1) to start the motor. At this moment, the 
PWM's LEDs indicate the motor powering. 

Step 4. Turn the Speed potentiometer clockwise to increase motor speed and 
counterclockwise to decrease motor speed. The Speed Adjust changes the PWM duty 
cycle of the PWM signals being sent to the MCP8027.

Step 5. Press and release the RUN switch again to stop the motor.

2.3.3 Indicator LEDs

The MCP8027 QFN40 BLDC Motor Driver Evaluation Board has seven LEDs to 
indicate system status. Table 2-3 lists the LED indicators and their description.

2.3.4 Test Points

There are several test points on the board that allow probing of voltages, currents and 
signals. An abridged listing is shown in Table 2-4.

TABLE 2-3: LED INDICATORS

PCB Location Name Description

Flt Fault Indicates Fault status

D2, D6, D9 PWMxL PWM Phase x low-side input to MCP8027

D4, D7, D10 PWMxH PWM Phase x high-side input to MCP8027

TABLE 2-4: TEST POINTS DESCRIPTION

Test Point Name Description

GND Power supply ground (–)

3.3V 3.3V buck voltage

+5V 5V internal LDO output

+12V 12V internal LDO output

DGnd Digital Reference ground

CE CE driver chip enable signal

DE2 DE2 communications signal

CP1/2 Charge pump flying capacitor input

VBA/B/C Bootstrap capacitor power input

LSA/B/C A/B/C Phase Low driver outputs

HSA/B/C A/B/C Phase High driver outputs
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 15
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2.3.5 Reprogramming the On-board dsPIC33CK128MP503

The on-board dsPIC33CK128MP503 may be reprogrammed with the user’s desired 
firmware. The processor may be programmed by using an external power source and 
either a PICkit 3, MPLAB® or REAL ICE™ in-circuit emulator, or a PICkit 4 programmer.

1. Connect the power source to the board as explained in Section 2.3.1.3.

2. Connect a PICkit 3 or a PICkit 4 to the J2 header.

3. Startup up the MPLABX Integrated Development Environment (IDE) and load the 
MCP8027 QFN40 BLDC Motor Driver Evaluation Board firmware project. 
In MCP802X.H, replace the definition for driver type: #define DRIVER MCP8027.

4. Build the project.

5. Program the device.

6. Press the RESET switch on the board to reset the processor and allow it to 
execute the new firmware program.

2.3.6 Configuring the MCP8027

The MCP8027 has configuration registers that may be used to modify the operating 
parameters of the device. The parameters are modified by sending commands to the 
MCP8027 using the DE2 communication bus. The DE2 communication bus is a 
half-duplex, 9600 baud, 8-bit, 1-stop bit, 1-start bit, no parity, serial communication link.

The user may add code to the evaluation board firmware to communicate with the 
registers. The evaluation board software contains a subroutine which initializes the 
MCP8027 registers.

There are three configuration registers that may be written to. The registers are written 
to by sending a SET_CFG_X command byte followed by the desired register value byte.

The configuration messages and their respective requests are listed in Table 4-5 of the 
MCP8027 Data Sheet, DS20006897, which is available at the corporate website 
(www.microchip.com).

2.3.7 MCP8027 Configuration Message Responses

A solicited response byte from the MCP8027 devices will always echo the command 
byte with bit 7 set to '0' (Response) and with bit 6 set to '1' for 'Acknowledged' (ACK) 
or '0' for 'Not Acknowledged' (NACK).

The second byte, if required, will be the data for the host command.

PHA/B/C A/B/C motor/driver phase signals

IO1/2/3 Sense Current Amplifier output for each phase

ILim ILIMIT_OUT signal from MCP8027

TABLE 2-4: TEST POINTS DESCRIPTION (CONTINUED)

Test Point Name Description

Note: Note that the following project options may need to be changed to allow the 
used computer to build the firmware:

• Add Library libdsp-elf.a located in the XC16  ???\src\Libdsp\lib 
directory.

• Add XC16-as ASM. Include Directory in XC16 ???\src\Libdsp\asm.

• Set hardware tool to “PICkit 3,” “PICkit 4,” or “REAL ICE”. 
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Table 4-6 in the MCP8027 Data Sheet, DS20006897, which is available at the 
corporate website at www.microchip.com, describes the messages sent to the host 
in response to a host command message.

If a multibyte command is sent to the MCP8027 device and no second byte is received 
by the MCP8027 device, then a ‘Not Acknowledged’ (NACK) message will be sent back 
to the host after a 5 ms time-out period.

The MCP8027 device may send unsolicited command messages to the host controller. 
No message is required as a response from the host controller.

2.3.7.1 MCP8027 REGISTER DEFINITIONS

The MCP8027 registers contain the bits operated on by the messaging system. The 
registers are only accessible via the various messages. The structure of the registers 
is listed below. (For more information see the MCP8027 datasheet.)

The communication interface uses a standard UART baud rate of 9600 bits per second. 
The transmit/receive packet must be done in Half-duplex mode. The host must listen 
to the DE2 line in order to check for contentions. In case of contention, the host must 
release the line and wait for at least three packets time length before initiating a new 
transfer.

CFG 2-0: CONFIGURATION REGISTER 0
U-0 R/W-1 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

— PU30K SLEEP NEUSIM EXTULVO EXTSC EXTOC1 EXTOC0

bit 7 bit 0

CFG 2-1: CONFIGURATION REGISTER 1
R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

DACREF7 DACREF6 DACREF5 DACREF4 DACREF3 DACREF2 DACREF1 DACREF0

bit 7 bit 0

CFG 2-2: CONFIGURATION REGISTER 2
U-0 U-0 U-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0

— — — DRVDT2 DRVDT1 DRVDT0 DRVBL1 DRVBL0

bit 7 bit 0

STAT 2-0: STATUS REGISTER 0
R-0 R-0 R-0 R-0 R-0 R-0 R-0 R-0

BUVLOF BUVLOW BIOCPW OVLOF DOVLOF UVLOF OTPF OTPW

bit 7 bit 0

STAT 2-1: STATUS REGISTER 1
U-0 U-0 R-0 R-1 R-0 R-0 U-0 U-0

— — UVLOF5V BORW XOCPF XUVLOF — —

bit 7 bit 0

Legend:

R = Readable bit W = Writable bit U = Unimplemented bit, read as ‘0’

- n = Value at POR ‘1’ = Bit is set ‘0’ = Bit is cleared x = Bit is unknown
 2024 Microchip Technology Inc. and its subsidiaries DS50003682A-page 17



MCP8027 QFN40 BLDC Motor Driver Evaluation Board User’s Guide
FIGURE 2-4: DE2 Packet Format and Timing.

2.4 SCHEMATIC PARTICULAR FEATURES

2.4.1 Current Sense Amplifier (CSA)

In order to avoid limitation for CSA output and assure the ADC range conversion, the 
initial offset of CSA is settled to around 1.65V. The total gain of the CSA is Gt = 16. As 
a recommendation, for high motor currents it is better to decrease the equivalent shunt 
resistor value to reduce the losses and to avoid analog limitation or any overflows in 
numerical computation.

For sense current detection the internal available operational amplifiers are configured 
as presented in Figure 2-5 for a high-speed robustness Current Sense Amplifier (CSA). 
CSA output is used, at the same time, by the internal over current comparator and by 
microcontroller's ADC for digital conversion.

FIGURE 2-5: Current Sense Amplifier Topology.
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FIGURE 2-6: Output Waveform of One CSA in Three Shunt, FOC Motor 
Control Mode.

2.4.2 Asymmetric Turn On/Off External MOSFET Bridge

In PMSM, FOC, three shunt, sensorless, motor control it is recommended to use an 
asymmetric Turn On/Off external MOSFET's bridge. Beside the others adverse effects 
reduction, this technique gives a more accurate waveform for CSA output, a better 
phase currents measuring and as a result a more robustness in motor control process. 
Figure 2-7 illustrates the CSA output improvement. 

FIGURE 2-7: Asymmetric Turn On/Off for One MOSFET Pair.
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2.5 APPLICATION HINTS
There are multiple combinations of motor types and MOSFETs used in external bridge 
and an excessive dV/dt can be achieved. Thus sometimes it is possible that dV/dt is 
just right to trigger the parasitic PNP between the two internal driver NMOS transistors. 
This transistor now discharges the external NMOS gate a little bit, thus reducing the 
dV/dt and switches off again, then the internal PMOS charges the gate again and thus 
discharges the bootstrap capacitor, so dV/dt increases, PNP is triggered again and so 
on. This repeats until the charging of the external gate no longer has enough dV/dt. 
(Figure 2-8).

FIGURE 2-8: Parasitic Triggering of the Bootstrap Capacitor Discharging.

Application improvement:

1. For bootstrap circuits, use Schottky diodes (for example SS24) with low direct 
voltage. Schottky diodes with low junction direct voltage provide as much voltage 
as possible across the bootstrap capacitors to prevent premature UVLO fault 
triggering. In the motor control process, especially at high duty cycle, the phase 
node could not reach the ground and as a result the bootstrap capacitors will not 
fully charge. Additionally, the user must properly choose the value of the 
bootstrap capacitors according to the used MOSFET. Due to the HS commuta-
tion, the voltage will start to decrease and might reach the OVLO threshold.

2. Add BOOTSTRAP VOLTAGE SUPPRESSION diodes for a better protection. In 
this case, the parasitic junction capacitance along with small value resistor 2-4Ω 
placed on each input phase will increase the noise sensitivity.

In general, for trapezoidal control mode, without swapping PWM commutation or for 
Discontinuous SPVM these capacitors should be larger than 0.22 μF to avoid 
excessive discharging and the DUVLO fault trigger.

• Before the motor energizing, the bootstrap capacitors must be charged by low 
side activation for a time depending on value of the bootstrap capacitors. 

• During this stage, the driver can give a D/UVLO fault condition, especially when 
large bootstrap capacitors are used (e.g. for trapezoidal motor applications). In 
this case a CLEAR FAULT sequence must be performed. 

• It is better to activate the OCP, UVLO protections after the bootstrap charging 
sequence. 

• The Duty Cycle value should be limited at: 
PWM period - Dead Time rising - Dead Time falling. 
A software duty cycle limitation for PWMs, correlated with dead time, is recom-
mended to allow the phase node to reach the 0V potential and the bootstrap 
capacitors recharging, to avoid false D/UVLO fault. In addition, if the blanking time 
is not enough large, false faults can be triggered.
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Appendix A. Schematics and Layouts
A.1 INTRODUCTION

This appendix contains the schematics and layouts of the MCP8027 QFN40 BLDC 
Motor Driver Evaluation Board:

• EV83F07A – Top Schematic

• EV83F07A – dsPIC Connections

• EV83F07A – Hall Effect Sensors Connection

• EV83F07A – Inverter

• EV83F07A – MCP8027

• EV83F07A – Power Supply

• EV83F07A – Power Supply Divider

• EV83F07A – Push Buttons

• EV83F07A – Speed Potentiometer

• EV83F07A – Top Silk

• EV83F07A – Top Copper and Silk

• EV83F07A – Top Copper

• EV83F07A – Bottom Copper

• EV83F07A – Bottom Copper and Silk

• EV83F07A – Bottom Silk
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Schematics and Layouts
A.7 EV83F07A – POWER SUPPLY

A.8 EV83F07A – POWER SUPPLY DIVIDER
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A.9 EV83F07A – PUSH BUTTONS

A.10 EV83F07A – SPEED POTENTIOMETER
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Schematics and Layouts
A.11 EV83F07A – TOP SILK

A.12 EV83F07A – TOP COPPER AND SILK
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A.13 EV83F07A – TOP COPPER

A.14 EV83F07A – BOTTOM COPPER
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Schematics and Layouts
A.15 EV83F07A – BOTTOM COPPER AND SILK

A.16 EV83F07A – BOTTOM SILK
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Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

4 C1, C16, C22, C24 Capacitor, ceramic, 0.1 μF, 25V, 
10%, X7R, SMD, 0603

Kyocera AVX® 06033C104KAT2A

3 C2, C4, C10 Capacitor, ceramic, 2.2 μF, 100V, 
10%, X7R, SMD, 1210

KEMET C1210C225K1RACTU

1 C3 Capacitor, ceramic, 2.2 μF, 50V, 
10%, X7R, SMD, 1206

TDK Corporation CGA5L3X7R1H225K160AB

3 C5, C6, C7 Capacitor, ceramic, 0.022 μF, 
25V, 10%, X7R, SMD, 0603

Kyocera AVX 06033C223KAT2A

2 C8, C9 Capacitor, ceramic, 2.2 μF, 10V, 
10%, X7R, SMD, 0603

Taiyo Yuden Co., Ltd. LMK107B7225KA-T

4 C11, C26, C28, C29 Capacitor, ceramic, 1 μF, 35V, 
10%, X7R, SMD, 0805

TDK Corporation CGA4J3X7R1V105K125AB

3 C12, C13, C14 Capacitor, ceramic, 39 pF, 50V, 
5%, C0G, SMD, 0603

Kyocera AVX 06035A390JAT2A

3 C15, C17, C21 Capacitor, ceramic, 4.7 μF, 25V, 
10%, X5R, SMD, 0805

Murata Electronics® GRM21BR61E475KA12L

3 C18, C19, C20 Capacitor, ceramic, 150 pF, 50V, 
5%, NP0, SMD, 0603

Panasonic® - ECG ECJ-1VC1H151J

2 C23, C25 Capacitor, ceramic, 10 μF, 10V, 
10%, X5R, SMD, 0805

Taiyo Yuden Co., Ltd. LMK212BJ106KG-T

1 C27 Capacitor, ceramic, 10000 pF, 
50V, 20%, X7R, SMD, 0603

Kyocera AVX 06035C103KAT2A

1 C30 Capacitor, tantalum, 10 μF, 35V, 
10%, 1Ω, SMD D

KEMET T491D106K035AT

1 C31 Capacitor, ceramic, 360 pF, 50V, 
5%, NP0, SMD, 0402

Walsin Technology 
Corporation

0402N361J500CT

2 CB1, CB2 Capacitor, aluminum, 470 μF, 
50V, 20%, TH, P5D12.5H20

Panasonic - ECG EEU-FM1H471

6 D2, D4, D6, D7, D9, 
D10

LED, yellow green, 0603, SMD Vishay®/Dale VLMG1300-GS08

6 D3, D8, D11, D12, 
D13, D14

Diode, Schottky, 40V, 2A, 
SOD-123F

Fairchild 
Semiconductor®/ON 
Semiconductor®

SS24FL

6 D15, D16, D17, 
D26, D27, D28

Diode, rectifier, array, 1.25V, 
200 mA, 70V, SOT-23-3

Micro Commercial 
Components (MCC)®

BAV99-TP

4 D18, D20, D22, D25 Diode, Schottky, 660 mV, 2A, 
60V, SOD-123

SMC Diode Solutions MBR260HWTR

3 D19, D21, D24 Diode, TVS, 33V, 200W, SMD, 
SOD-123FL

Panjit International 
Inc.

SMF33A_R1_00001

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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1 D23 Diode, LED, amber, 2.1V, 25 mA, 
2mcd, clear, SMD, 0603

Lite-On®, Inc. LTST-C190AKT

1 F1 Resistor, fuse, 15A, 24V, fast, 
SMD, 1206

Multicomp Pro MP005485

1 FB1 Ferrite, 600R@100 MHz, 
300 mA, SMD, 0603

Laird Technologies® HZ0603C601R-00

1 J1 Connector, terminal, 5.08 mm, 
1x2, female, 14-22AWG, 15A, 
TH, R/A

On-Shore 
Technology, Inc.                                                                           

OSTTC022162

2 J2, J3 Connector, HDR-2.54, male, 1x6, 
gold, 5.84 MH, TH, R/A

FCI 68016-106HLF

1 J4 Connector, terminal, 2.54 mm, 
1x5, female, 20-30AWG, 6A, TH, 
R/A

Phoenix Contact 
GmbH & Co.

1725685

1 JM1 Connector, terminal, 5 mm, 1x3, 
female, 12-30AWG, 16A, TH, R/A

Wϋrth Elektronik 691137710003

1 Jp7 Connector, HDR-2.54, male, 1x2, 
tin, 6.75 MH, TH, vertical

Molex, LLC 0901200122

1 Js2 Mechanical, headers and wires, 
jumper, 2.54 mm, 1x2, gold

Wϋrth Elektronik 60900213421

1 L1 Inductor, 3.3 μH, 1.5A, 20%, 
SMD, L3W3H1.5

Wϋrth Elektronik 74404032033

1 LABEL1 Label, PCBA, 18x6 mm, 
Datamatrix 
Assy#/Rev/Serial/Date

ACT Logimark AS 505462

6 Q1, Q2, Q3, Q4, 
Q5, Q6

Transistor, MOSFET, 
N-Channel, 75V, 48.2A, 106W, 
SOT-669

Nexperia BUK9Y19-75B,115

1 R1 Resistor, thick film, 36k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3602V

1 R2 Resistor, thick film, 2.4k, 1%, 
1/10W, SMD, 0603

Yageo Corporation RC0603FR-072K4L

7 R3, R5, R9, R12, 
R15, R18, R66

Resistor, thick film, 2k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF2001V

6 R4, R14, R19, R23, 
R28, R33

Resistor, thick film, 39R, 1%, 
1/8W, SMD, 0805, AEC-Q200

Stackpole 
Electronics, Inc.

RMCF0805FT39R0

6 R6, R16, R20, R24, 
R29, R34

Resistor, thick film, 10R, 1%, 
1/8W, SMD, 0805

ROHM 
Semiconductor

MCR10EZHF10R0

6 R7, R17, R21, R25, 
R30, R35

Resistor, thick film, 330k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ334V

3 R11, R22, R32 Resistor, thick film, 3.3R, 1%, 
1/8W, SMD, 0805

Vishay/Dale CRCW08053R30FKEA

1 R26 Resistor, thick film, 47k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ473V

1 R27 Resistor, thick film, 2.2R, 5%, 
1/10W, SMD, 0603

Stackpole 
Electronics, Inc.

RMCF0603JT2R20

5 R31, R38, R50, 
R53, R64

Resistor, thick film, 47k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF4702V

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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3 R36, R37, R39 Resistor, thick film, 12k, 1%, 
1/10W, SMD, 0603

Stackpole 
Electronics, Inc.

RMCF0603FT12K0

4 R40, R69, R70, R71 Resistor, thick film, 120R, 1%, 
1/10W, SMD, 0603

Stackpole 
Electronics, Inc.

RMCF0603FT120R

6 R41, R42, R43, 
R44, R47, R48

Resistor, thick film, 330R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3300V

3 R45, R46, R49 Resistor, thick film, 39k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3902V

4 R51, R52, R54, Ra1 Resistor, thick film, 9.1k, 1%, 
1/10W, SMD, 0603

Yageo Corporation RC0603FR-079K1L

6 R55, R56, R57, 
R58, R59, R60

Resistor, thick film, 470R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF4700V

3 R61, R62, R63 Resistor, thick film, 1.3k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ132V

3 R65, R67, R68 Resistor, thick film, 10k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ103V

1 R72 Resistor, thick film, 18k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ183V

1 R73 Resistor, thick film, 240R, 1%, 
1/10W, SMD, 0603

Yageo Corporation RC0603FR-07240RL

1 R74 Resistor, thick film, 1.8k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF1801V

4 R78.A, R79.A, 
R80.A, R81.A

Resistor, thick film, 0R, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-070RL

1 R82.A Resistor, thick film, 0R, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GSY0R00V

1 Rb1 Resistor, thick film, 15k, 1%, 
1/10W, SMD, 0603, AEC-Q200

Vishay/Dale CRCW060315K0FKEA

3 RS1, RS2, RS3 Resistor, shunt, ME, 0.003R, 1%, 
4W, AEC-Q200, SMD, 2512

Vishay/Dale WSLF25123L000FEA

1 Rv1 Resistor, variable, 10K, 20%, TH, 
P090S

BI Technologies/TT 
Electronics

P090S-14T20BR10K

4 ST1, ST2, ST3, ST4 Switch, tact., SPST, 24V, 50 mA, 
KSR231GLFS, SMD, 6 x 3.5 mm

TE Connectivity 
Alcoswitch

147873-2

2 TP10, TP26 Connector, test point, tab, 
Silver, Mini, 3.8 x 2.03, SMD

Keystone® 
Electronics Corp.

5019

3 TP25, TP-1, TP-2 Connector, test point, tab, 
silver, mini, 3.8x2.03, SMD

Keystone 
Electronics Corp.

5019

1 PCB1 Printed Circuit Board — 04-12178-R1

TABLE B-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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TABLE B-2: BILL OF MATERIALS (BOM) – MICROCHIP PARTS

Qty. Reference Description Manufacturer Part Number

1 U1 MCU, 16-Bit, 100 MHz, 
128k,16k, UQFN-36

Microchip 
Technology, Inc.

DSPIC33CK128MP503-E/M5

1 U2 Analog, Motor Driver, QFN-40 Microchip 
Technology, Inc.

MCP8027T-H/Q9X

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.

TABLE B-3: BILL OF MATERIALS (BOM) – DO NOT POPULATE PARTS

Qty. Reference Description Manufacturer Part Number

0 D1 Diode, Zener, 27V, 500 mW, 
SOD-123

Diodes Incorporated® BZT52C27-7-F

0 D5 Diode, LED, yellow, 2.1V, 30 mA, 
10 mcd, diffuse, SMD, 0805

Lumex® Inc. SML-LXT0805YW-TR

0 HVI-ext Connector, HDR-2.54, male, 
1x2, tin, 6.75 MH, TH, vertical

Molex, LLC 0901200122

0 QC1 Transistor, MOSFET, 
N-Channel, 100V, 100A, 139W, 
TDSON-8

Infineon 
Technologies AG

BSC040N10NS5ATMA1

0 R10 Resistor, thick film, 10k, 5%, 
1/2W, SMD, 0805

Panasonic - ECG ERJ-P06J103V

0 R13 Resistor, thick film, 2.2k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ222V

0 R78.B, R79.B, 
R80.B, R81.B

Resistor, thick film, 0R, 1/10W, 
SMD, 0603

Yageo Corporation RC0603FR-070RL

0 R82.B Resistor, thick film, 0R, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GSY0R00V

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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Appendix C. Software
C.1 SOFTWARE LOCATION

The application software may be downloaded from the MCP8027 web page located on 
the Microchip website, http://www.microchip.com.

C.2 DSPIC33CK128MP503 PORT USAGE

C.2.1 Port's Mapping

/**********************   PWMs are outputs **************************/

LATBbits.LATB10 = 0;

TRISBbits.TRISB10 = 0; // PWM3H

LATBbits.LATB11 = 0;

TRISBbits.TRISB11 = 0; // PWM3L

LATBbits.LATB12 = 0;

TRISBbits.TRISB12 = 0; // PWM2H

LATBbits.LATB13 = 0;

TRISBbits.TRISB13 = 0; // PWM2L

LATBbits.LATB14 = 0;

TRISBbits.TRISB14 = 0; // PWM1H

LATBbits.LATB15 = 0;

TRISBbits.TRISB15 = 0; // PWM1L

/*********************  MCP802X CEn *****************************/

LATBbits.LATB8 = 0;

TRISBbits.TRISB8 = 0; // C_En

/*********************** Push Buttons ports *********************/

LATBbits.LATB5 = 1; // Input OnOff button (Dir)

TRISBbits.TRISB5 = 1;

LATBbits.LATB6 = 1; // Input Spare button (Run)

TRISBbits.TRISB6 = 1;

/************************ LED *****************************/

LATCbits.LATC3 = 0;

TRISCbits.TRISC3 = 0; // Fault_LED
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C.2.2 Macro Limits Definition and their Conversion

C.2.3 Driver Initialization Sequence

/************************ DE2 - UART1 pins ***************************/

TRISBbits.TRISB9 = 1; // RX

TRISCbits.TRISC4 = 0; // TX

/************************ UART pins ***************************/

TRISBbits.TRISB1 = 0; // TX

TRISBbits.TRISB0 = 1; // RX

//**** Values Limits sittings ***********************************************//

#define DeadTime 750 // 250;500; ...2000  [ns]

#define BlankTime 2000 // 500;1000;2000;4000[ns]

#define DAC_Vref 3195 // 991;1005;...4500  [mV} -DAC 
Overcurrent Limit

#define MOS_OCL 500 // 250;500;750;1000  [mV] -MOSFET 
Overcurrent Limit

/******************** MCP802X registers definition *********************/

//Send driver configuration --command data

#define SET_CFG_0 0x81 // CFG_0 Writing command

#define GET_CFG_0 0x82 // CFG_0 reading command

#define SET_CFG_1 0x83 // CFG_1 Writing command

#define GET_CFG_1 0x84 // CFG_1 reading command

#define GET_STAT0 0x85 // Get Status Register

#define GET_STAT1 0x86 // Get Status Register

#define SET_CFG_2 0x87 // CFG_2 Writing command

#define GET_CFG_2 0x88 // CFG_2 reading command

/*****************************************************************************/

/***        MCP802x driver initializations as defined in “MCP802X.h”       ***/

/*****************************************************************************/

xCFG0.CFG0 = 0x00; // For sure reset CFG0 content

xCFG0.EXTOC = Set_MOS_OCL(); // Set MOSFET threshold limit

xCFG0.EXTSC = Disabled;//Enabled; // Ext. MOSFET Over Current 
protection

xCFG0.D_UVLO = Disabled;//Disabled; // Driver UVLO protection

xCFG0.SLEEP = Inactive; // Active driver enters in Sleep mode

xCFG0.INT_N = Inactive; // Internal Neutral Simulator

xCFG0.PU30_OA = Disabled;

xCFG1.CFG1 = 0; // For sure reset CFG1 content

xCFG1.CFG1 = Set_DACref(); // Set DAC I_Lim reference

xCFG2.CFG2 = 0; // For sure reset CFG2 content
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C.2.4 A/D Mappings

C.2.5 UARTs and Interrupts Mappings

xCFG2.DRVDT = Set_DeadTime(); // Set desired dead time

xCFG2.DRVBL = Set_BlankTime(); // Set desired blanking time

MCP802x_Clr_Faults();

MCP802x_Drv_Init();

/** ADC Channel Definition */

typedef enum

{

ADC1_MON1 = 12,

ADC1_MON2 = 13,

ADC1_MON3 = 14,

ADC1_IO1 = 4,

ADC1_IO2 = 3,

ADC1_IO3 = 7,

ADC1_Speed = 0,

ADC1_VBdiv = 2,

} adc_channel_t;

builtin_write_RPCON(0x0000); // Unlock Registers

_U1RXR = 41; // Assign U1Rx To Pin RP41 on RB9

_RP52R = 1; Assign U1Tx To Pin RP52 on RC4

_U2RXR = 32; Assign U2Rx To Pin RP32 on RB1

_RP33R = 3; // Assign U2Tx To Pin RP33 on RB0

_ INT1R = 53; // Assign External Interrupt 1 To 
Pin RP53 on RC5

//IRQ

_ INT2R = 37; Assign External Interrupt 2 To 
Pin RP37 on RB5

//OnOff

_ INT3R = 38; // Assign External Interrupt 3 To 
Pin RP38 on RB6

//Spare

__builtin_write_RPCON(0x0800); // Lock Registers
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C.3 COMMUNICATIONS MESSAGE MAPPINGS

C.4 MPLAB X COMPILER STARTUP

1. Start up the MPLAB X compiler (not supplied, available on the Microchip 
website).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing project file named MCP8027EvB_3Sh_ckX03.X
5. In the Projects window, right mouse-click on MCP8027EvB_3Sh_ckX03.X and 

select Properties. The page contains the project properties. Processor, Compiler, 
Hardware and Config settings may be changed here.

6. Right mouse-click on MCP8027EvB_3Sh_ckX03.X again and select “Make and 
Program Device”. This will compile the firmware and download it to the 
programming hardware.

7. The compiler results will be displayed in the Output window frame. Verify 
success.

/******************** MCP802X registers definition *********************/

//Send driver configuration --command data

#define SET_CFG_0 0x81 // CFG_0 Writing command

#define GET_CFG_0 0x82 // CFG_0 reading command

#define SET_CFG_1 0x83 // CFG_1 Writing command

#define GET_CFG_1 0x84 // CFG_1 reading command

#define GET_STAT0 0x85 // Get Status Register

#define GET_STAT1 0x86 // Get Status Register

#define SET_CFG_2 0x87 // CFG_2 Writing command

#define GET_CFG_2 0x88 // CFG_2 reading command

Note: The user may need to modify the paths to the source files and linker files 
for PID controller implementation, based upon their locations on the host 
computer. Be sure to verify the Libraries contain the correct path to 
libdsp-elf.a
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C.5 MPLAB X IDE AND PICKIT 3 EXERCISE

1. Start up the MPLAB X (not supplied, available on the Microchip website).

2. From the toolbar, select File>Open Project.

3. Browse to the evaluation board source code path.

4. Select the existing workspace directory named MCP8027EvB_3Sh_ckX03.X or 
create a new one.

5. Connect the C Align Pin 1 of the header with the Pin 1 mark on the programmer.

6. Set the bench power supply voltage control to minimum voltage output.

7. Turn on the power supply and set the output voltage to 13-14V. Turn off the power 
supply.

8. Connect the bench power supply to the evaluation board. Connect +V(14V) to 
J1-2 and -V (Ground) to J1-1.

9. Turn on the power supply.

10. Right mouse-click on MCP8027EvB_3Sh_ckX03.X in the Projects window and 
select “Make and Program Device”. This will compile the firmware and program 
the dsPIC33CK128MP503 processor.

11. The compiler results will be displayed in the Output window frame. Verify 
success.

12. Connect a Brushless DC (BLDC) motor to connector JM1 (MOTOR). Connect 
the motor phase wires to the PH_A, PH_B, and PH_C terminals.

13. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

14. Turn the SPEED adjustment fully counterclockwise. This sets the motor to the 
slowest speed.

15. Momentarily press the ST1 (RUN) switch to start the motor.

16. Momentarily press the ST1 (RUN) switch again to stop the motor.

17. Momentarily press the ST1 (RUN) switch again to start the motor.

18. Turn the SPEED adjustment clockwise. The motor speed should increase.

19. You may probe the different test points on the board to see the various signals 
being generated. The LSA, LSB, LSC, HAS, HSB, HSC test points will show the 
external MOSFET gate drive signals. The D2, D4, D6, D7, D9, D10 LEDs show 
the state of the PWM inputs to the MCP8027. 

20. Stop the motor by pressing RUN again.

21. Change the motor control from Open Loop to Closed Loop mode by uncomment-
ing the directive where OPENLOOPmode is undefined. This is done by editing 
the UserParams.H file.

22. Click on Source Files in the Projects window and then double-click on the 
UserParams.h entry.

23. Search for the preprocessor definition #undef OPENLOOPmode.

24. Uncomment this line.

25. Right mouse-click MCP8027EvB_3Sh_ckX03.X in the Projects window and 
select “Make and Program Device”. This will compile the firmware and program 
the dsPIC33CK128MP503-E/M5 controller.

26. The compiler results will be displayed in the Output window frame. Verify 
success.

27. Momentarily press the RESET switch on the evaluation board. This step is 
required to reset the dsPIC DSC device after programming.

28. Turn the SPEED adjustment fully clockwise at around 50%-70%. This sets the 
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motor target speed.

29. Momentarily press the RUN switch again to start the motor.

30. The motor speed should increase with FLT LED on until the closed loop will be 
done. At this moment FLT LED turns off and the speed stabilizes. If the motor is 
loaded the speed is maintained.

31. In OPENLOOPMODE, the motor speed is forced based upon the position of the 
SPEED adjust potentiometer. If the SPEED adjust is set to 60%, the firmware will 
set the PWM duty cycle to 60%. While this allows for simple control of the motor, 
it is not efficient. If the motor is externally loaded, the motor may not be able to 
maintain the manually set commutation time which will result in a motor stall. The 
motor runs more efficiently when the motor is allowed to commutate based upon 
rotor location and not by an external reference. In CLOSEDLOOPMODE, the 
motor will commutate at the proper time based upon the Back EMF information. 
If the motor is externally loaded, the motor will automatically adjust for the load 
to maintain the correct commutation time.

32. Momentarily press the RUN switch again to stop the motor.
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